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Caution 

The default or operating values used in this manual and in the program of the 

microLoad.net are for factory testing only and should not be construed as default or 

operating values for your metering system. Each metering system is unique and each 

program parameter must be reviewed and programmed for that specific metering 

system application. 

Disclaimer 

Guidant hereby disclaims any and all responsi-bility for damages, including but not 

limited to consequential damages, arising out of or related to the inputting of incorrect 

or improper program or default values entered in connection with the microLoad.net. 
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Product Description 

microMate for microLoad.net is a Windows application that facilitates configuration of the Smith Meter micro-
Load.net series of electronic presets. microMate allows the user to configure existing parameters, create custom 
reports, translate microLoad.net interface text, and create custom equation sets.  

microMate supports context-sensitive help. Press "F1" from any location for detailed help on a particular feature, 
or select "Index" from the Help menu to browse the index. 

A CRC table is maintained for each revision of microLoad.net. When communication is established with a unit, the 
revision is examined. Any discrepancies, such as an unknown revision or a type mismatch, are reported to the 
operator.   

microMate allows the user to work with several files simultaneously. In the context of the microMate, a "file" is the 
data associated with one microLoad.net. When multiple files are open, the currently active window is the one that 
will be affected by menu choices and toolbar options. 

Modes of Operation 

Offline Mode 

In the Offline mode of operation, the microMate can be used to completely set up a data file or edit an existing file. 
This file can then be saved for future use. By switching to Online mode, the file can be downloaded to the micro-
Load.net. 

Online Mode 

The Online and Read Only modes of operation require that the microLoad.net and the microMate's communica-
tions port are configured with the same baud rate, parity, protocol, and address. In addition, a file should be cre-
ated for each microLoad.net with which the microMate is to communicate. A file is created by selecting "File" in 
the upper left-hand corner of the microMate's toolbar, then selecting "New," then "microLoad.net Data File." 

Read Only Mode 

Read Only mode is used to read information from the microLoad.net. The program may enter the Read Only 
mode for one of several reasons, including insufficient security access, transaction in progress, already in pro-
gram mode at keypad, or an incorrectly programmed communications port control. An error message will appear. 
If the operator clicks "OK" and presses "ENTER" on the computer keyboard, the microMate will automatically go 
into the Read Only mode and no data will be exchanged. 

Once the setup is complete, communications can be established and information can be passed between the  
microMate and the microLoad.net. 

When in the Online mode, the microMate can be used to configure the microLoad.net, read information from the 
microLoad.net, and dump directories or entire files to the microLoad.net. Information is sent to the microLoad.net 
by using the "dump" icons on the microMate toolbar.  

 

Online Help 

To access microMate's built-in help function, type Alt-H from the keyboard or click on "Help" at the top right of the 
microMate screen. These actions display the Help menu. Select "Contents" for an index of built-in help topics, or 
"Visit Smith Meter Web Site" for Internet access to information about Smith Meter products, upcoming events, lo-
cal representatives, and Smith Meter divisions (Internet access and compatible browser required). The operator 
can also press F1 at any time for context-sensitive help. 
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System Requirements 

The microMate will operate on an IBM-PC compatible (486 or better) computer operating in a Windows environ-
ment (Windows 95 or later) with at least 4M of memory. The hard drive should have at least 2M of free disk 
space.  A floppy disk, or CD-ROM drive is also required depending upon media type that you have received.   

microMate is also available for download over the internet at:  
http://www.fmctechnologies.com/measurementsolutions.

http://www.fmctechnologies.com/measurementsolutions
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Installing microMate  

microMate is available for download on our website at: 
http://www.fmctechnologies.com/en/MeasurementSolutions/OnlineServices/Software/microLoadNet.aspx. 

Select the link, run the file and follow the installation instructions. 

http://www.fmctechnologies.com/en/MeasurementSolutions/OnlineServices/Software/microLoadNet.aspx
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Program Files 

During the installation process, the following files will have been copied to the PC's hard drive. These files may be 
viewed by opening Windows Explorer and selecting the microMate directory. 

microMate for microLoad.net 
 microMate.cnt

 microMate.exe (launches the program)

 microMate.hlp (contains online help)

 Default settings – TCPIP.ml (contains the default settings for an microLoad.net)

 Default Prove Report.RPM

 Default Trans Report.RPM

 Sample Display.DPM

 Sample driver database.DDM

 Sample Equations.EQM

Contact a Smith Meter directly at measurement.solutions@fmcti.com if any of these files are missing, or if there 
are any other problems with the microMate installation. 

File Extensions 

microLoad.net file names are typically followed by a two- or three-letter extension (e.g., .ML). The extension indi-
cates the nature of the file. 

 .ML files – microLoad.net configuration files

 .RPM files – microLoad.net configurable report definition files

 .DDM files – microLoad.net database files

 .DPM files – microLoad.net display definition files

 .EQM files – microLoad.net equation files.

mailto:measurement.solutions@fmcti.com
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Establishing Communications 

In order for communications to function, the microLoad.net and microMate setups must be compatible and the 
communications cable correctly wired. Several microLoad.net parameters (including communications port, baud 
rate, data bits, and parity) must be properly set to enable communications. The microMate setup must then be 
configured to match the microLoad.net parameters. 

Serial Communication Cable Wiring 

Select an available communications port. COM1 is configured for the microMate by default in the microLoad.net. 
Only three wires are necessary for EIA-232 serial communications. They must be connected as shown in the  
diagrams below. 

 

Figure 1.    9 Pin Communications Connector Wiring 
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Figure 2.    25 Pin Communication Connector Wiring 
 
Good shielding practices are recommended when wiring communications cables. The DB-25 connector has a pin 
dedicated to shield (Pin 1). Pin 1 is not a shield pin on the DB-9 connector. Connect (solder) the shield conductor 
to the DB-9 connector’s metal case. If that is impractical, in most cases it is acceptable to terminate the shield at 

Pin 5 along with the signal ground. It is not recommended that shield wiring be terminated at the microLoad.net, 
especially in multi-drop environments. 

Due to the fact that the microLoad.net serial ports have additional hardware to allow multiple units to share a sin-
gle EIA-232 port, the PC’s receive pin is left in a floating state during idle time. This can result in some PCs (es-
pecially laptop computers) being susceptible to echo, which can interfere with the serial communications reliabil-
ity. Sometimes installing a resistor (~1K) between microLoad.net TX and COM can improve communications in 
these situations. For example, on microLoad.net COM1, the resistor would be installed (like a jumper) from CN2-1 
to CN2-5. 
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Ethernet Cable Wiring 

Ethernet cable must meet the requirements of CAT5 at a minimum. Direct Ethernet connections between com-
puter and microLoad.net require a crossover cable configuration. Standard straight cable configuration is used 
where the microLoad.net units are networked through a hub or switch. An Ethernet connection at the micro-
Load.net is made by a RJ-45 connector labeled CN-8 located on the MNET circuit board. 

Communications Port Setup 

Each microLoad.net file stores the address used for communications, the PC port to which it is attached, and oth-
er important information. Because each microLoad.net has its own file, there is no need to change communica-
tions settings when moving among multiple microLoad.nets connected to the same PC (as in a load rack envi-
ronment, for example). All microLoad.nets on the same PC comm port must have the same port settings and pro-
tocol (either terminal or minicomputer).  

To begin communicating with the microMate, set up the communications port using the Options|Options for this 
microLoad.net… menu choice. The dialog presented allows for setup of both the communications port and the 
communications protocol. 

Ethernet users need only select “TCP/IP” from the Com Port dropdown list and enter the IP address of the micro-
Load.net in the “microLoad.net Address” data. No further “Comm Settings” are required. 

To set up a serial communications port, first determine the available communications ports on the PC. If COM1 is 
available (not connected to a mouse, modem, or some other device), connect your communications line to the 
COM1 (Serial Port 1) connector on the back of the PC. Select COM1 in the combo box. (See Figure 3.) If both are 
in use, select either COM3 or TCP/IP if present. Be aware that in most PCs, COM1 and COM3 cannot be used 
simultaneously, nor can COM2 and COM4 be used simultaneously. Extender boards for serial communications 
(e.g., DigiBoards) can be used as long as they support the Windows communications API standard. 

Another alternative is to use SLIP (Serial Line Internet Protocol). SLIP uses a microLoad.net serial communica-
tions port to employ TCP/IP communications with a minicomputer type device. (Refer to microLoad.net Communi-
cations Manual MN06147, Appendix VI for information on setting up SLIP communications.) 

To configure the communications settings, open an existing microLoad.net file or create a new one, then select 
Options|Options for this microLoad.net... Click the "Comm Settings" button on the dialog box to select the desired 
baud rate (38,400 is recommended), using the same baud rate for both the microMate and the microLoad.net. 
Data/Parity must be 8 Bits, No Parity (8 Bits None). Because some data transfers are binary, all eight bits are 
needed for the data. 

 

http://info.smithmeter.com/literature/docs/mn06147.pdf
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Figure 3.    Communications Setup 
 

Initiating Communications with the microLoad.net 

To configure the microLoad.net for communications, do the following: 

1. Connect the selected PC communications port to a microLoad.net communications port. 

2. Select an existing microLoad.net file, or create a new one, by choosing "Open" or "New" under "File" on the 
microMate toolbar. 

3. A display similar to that shown below will appear on the computer screen. Communication configuration pro-
gram codes are in the "700" System Communications group, as shown in Figure 4 below. 

4. To configure an option, use the mouse to select the appropriate program code and then double click. A dialog 
box will appear that allows the user to enter information for that parameter. 

Example: To specify the comm address for a specific microLoad.net, choose "704: microLoad.net Comm 1 
Control." From the pulldown list select the degree of control to be exercised from Comm. 1 and click "OK." 
The microLoad.net's Control Mode will appear in the right-hand column labeled "Value." 
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Figure 4.    Communications Directory 
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Figure 5.    Comm Control Example 
 
 
Note: Unless automation level control is desired, choose Poll & Program for the microMate in the Comm Control parameter. Poll & Program is 
also a good selection for demonstrations, since it allows batches to be run without remote authorization. 

For detailed information about program codes, refer to the microLoad.net Operator Reference Manual, MN06148. 

Once the communications configuration is complete, do the following: 

1. Open an microLoad.net data file. Select Options| Options for this microLoad.net, and verify the microLoad.net 
address.  

2. Verify that the communications port is set to the port on the PC, and that the selected protocol matches that 
programmed at the microLoad.net.  

3. If the parity and baud rate are not correct, change them using the "Comm Settings" button in the dialog box. 

4.  Close the "Options" dialog. 

If all is working properly, the status bar text (at the bottom of the screen) should change from "Offline" to "Online" 
mode. If the status bar indicates "Read Only," verify that the microLoad.net is not in Program mode at the keypad, 
and that all programmed security requirements have been met at the microLoad.net. 

http://info.smithmeter.com/literature/docs/mn06148.pdf
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Troubleshooting 

If difficulty is encountered, verify the accuracy of the following: 

 Communications setup at the microMate 

 Communications setup at the microLoad.net 

 Port, baud rate, and parity 

 Protocol (Terminal or Minicomputer); minicomputer is recommended 

 microLoad.net address 

 Wiring between the microLoad.net and the PC (Are transmit and receive connections reversed? Is the cable 
connected to the proper comm port at both the microLoad.net and the PC?). 

 



Section IV – Operations 

 

 MN06152 Issue/Rev. 0.2 (10/13) 12 

 

Program Startup [start here] 

The microMate, when launched, will open to a screen similar to that shown in the figure below. An operator can 
work with more than one file at a time. In the context of the microMate, a "file" is the data associated with one 
specific microLoad.net. Multiple microLoad.net files can be open at one time as separate documents on the desk-
top. 

   
  

 

Figure 6.    microMate Startup 
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Data and Functions 

The data and functions that can be accessed or accomplished from this screen are as follows. 

File Menu 

Access the File menu by clicking "File," which appears at the far left of the microMate menu bar (at the top of the 
microMate screen). 

New: A new microLoad.net data file will be created. (Other functions available under "New," including "Report 
Configuration," "Translation," "Equation Set," “Driver Database”, and “Display Configuration” will be discussed in 
other sections of this manual.).  

Open: Opens an existing microLoad.net file. 

Close: Closes an open microLoad.net file. 

Save: Saves changes to the current file to disk. 

Save As: Displays a dialog box that allows a new name to be assigned to a file. 

Print: Prints either the current directory or all the parameters in the active microLoad.net file. 

Print Preview:  Displays a preview on the screen of what would be printed.  

Print Setup:  Displays a dialog box which provides means for altering printer properties and settings. 

Exit: Exits the program. 

Edit Menu 

Access the Edit menu by clicking "Edit" on the microMate menu bar. 

Cut: Removes the selected text and places it on the clipboard. 

Copy: Copies the selected text and places it on the clipboard. 

Paste: Inserts the text stored on the clipboard at the location of the cursor. 

Read Selected Folder: Loads values from the microLoad.net into the currently selected directory or 
subdirectory. "Read Selection" can also be activated by clicking its icon on the microMate toolbar. 
From either of these options, the operator can choose to read a specific directory from the active 
microLoad.net. When the data reading is complete, the program will return to the previous screen. 

Read All: Reads all values associated with the active file from the microLoad.net. "Read All" can al-
so be activated by clicking its icon on the microMate toolbar. From either of these options, the oper-
ator can choose to read all data from the active microLoad.net. When the data reading is complete, 

the program will return to the previous screen. 

Dump Selected Folder: Sends the current selection to the microLoad.net. "Dump Selection" can 
also be activated by clicking its icon on the microMate toolbar. From either of these options, the  
operator can choose to download a specific directory to the active microLoad.net. When the data  

        transfer is complete, the program will return to the previous screen. 

Dump All: Sends all data in this file to the microLoad.net. "Dump Selection" can also be activated 
by  clicking its icon on the microMate toolbar. From either of these options, the operator can choose 
to download all data from the microMate to the active microLoad.net. When the data  

         transfer is complete, the program will return to the previous screen. 
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Tools Menu 

The Tools menu is accessed by clicking "Tools" on the microMate menu bar. (This menu is only available for .ML 
files) 

Terminal Emulator (Alt-F10): The Terminal Emulator is a "smart" terminal emulator that formats commands to 
be sent to the microLoad.net. It is accessed by selecting Tools|Terminal Emulator from the microMate toolbar. 
Terminal Emulator supports both Terminal and Minicomputer modes, and processes all required framing charac-
ters. The operator types only the actual command and any associated command qualifiers. From this interface, 
the operator can send any of the commands in the microLoad.net repertoire. 

The Terminal Emulator features a pull-down menu, Commands, on the toolbar. From this menu, the operator can 
browse all commands in the microLoad.net command set. As each command is highlighted, information about the 
command will appear on the application's status bar. Once an item is selected, pressing "F1" will display the help 
message for that particular command. If a command requires no additional information, it will be sent immediately. 
The pull-down menu at the upper right-hand corner of the terminal emulator display allows the operator to select 
the arm with which communications will interact. 

 

Figure 7.    Terminal Emulator Commands 
 
Refer to the microLoad.net Communications Manual, MN06147, for additional information about microLoad.net 
commands. 

 

Transaction Log to File…: This feature creates a backup of transaction data on disk. Its purpose is to prevent 
complete loss of data when reinitializing a microLoad.net, such as when upgrading software. Because initializa-
tion erases the microLoad.net's flash memory, the transaction log is destroyed. 

When "Transaction Log to File" is selected, the operator will be prompted to select a file name. The default name 
is (microLoad filename)-TransLog.txt. The file will be saved in a comma-delimited text format that may be opened 
in a spreadsheet program, such as Microsoft Excel, that sorts the data into readable columns based on the 
placement of commas in the text. 

Note: This option is only available when the microLoad.net is online and its file is open and active on the microMate. 

Event Log to File…: This feature creates a backup of event data on disk. Its purpose is to prevent complete loss 
of data when reinitializing a microLoad.net, such as when upgrading software. Because initialization erases the 
microLoad.net's flash memory, the event log is destroyed. 

http://info.smithmeter.com/literature/docs/mn06147.pdf
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When "Event Log to File" is selected, the operator will be prompted to select a file name. The default name is (mi-
croLoad filename)-EventLog.txt. The file will be saved in a comma-delimited text format that may be opened in a 
spreadsheet program, such as Microsoft Excel, that sorts the data into readable columns based on the placement 
of commas in the text. 

Note: This option is only available when the microLoad.net is online and its file is open and active on the MicroMate. 

Audit Trail Log to File…: This feature creates a backup of audit trail data on disk. Its purpose is to prevent com-
plete loss of data when reinitializing a microLoad.net, such as when upgrading software. Because initialization 
erases the microLoad.net's flash memory, the audit trail log is destroyed. 

When "Audit Trail Log to File" is selected, the operator will be prompted to select a file name. The default name is 
(microLoad filename)-AuditLog.txt. The file will be saved in a comma-delimited text format that may be opened in 
a spreadsheet program, such as Microsoft Excel, that sorts the data into readable columns based on the place-
ment of commas in the text. 

Note: This option is only available when the microLoad.net is online and its file is open and active on the MicroMate. 

Retry Communications: This feature sends a status request to the microLoad.net to determine the viability of 
communications between the MicroMate and the microLoad.net. This command is generally used after changes 
to communications settings to ascertain the current communication status, or after using the "Go Offline" com-
mand. 

Go Offline: Terminates communications between the MicroMate and the microLoad.net, allowing the operator to 
make changes to the file that do not immediately affect the microLoad.net. 

Upgrade Firmware…: There are occasions where new features / enhancements are made to the microLoad.net 
software package, requiring the end user to perform an upgrade procedure to obtain these new features. Because 
each revision of microLoad.net firmware released by Smith Meter is accompanied by a revision to microMate, up-
grade both microMate and microLoad.net together (There may be rare exceptions to this, in which case some no-
tification will be made). The following recommendations are designed to ease this operation and ensure that the 
upgrade goes smoothly: 

1.  Back up all data on the microLoad.net using microMate before upgrading anything. Make sure your .ml 
file representing the microLoad.net settings is up to date: Open the appropriate microLoad.net (.ml) file. 
Perform a Read All. Save the file.  

2.  If any of the following items exist at the microLoad.net (and you do not already have them stored) read 
and store them as well: Report Configuration(s) (.RPM), Translation (.LGM) and custom Boole-
an/Algebraic equation set (.EQM). (Note: To read these items, you must be in the appropriate editor for 
the item… so create a dummy file, then select read all. For example, if you want to read out the current 
Report Configuration, select File | New | Report Configuration once you are online and then, while the 
new file is active, select Read from the Edit menu or toolbar) 

3.  Retrieve the event and transaction logs using microMate if desired via the Tools menu. This infor-
mation will be lost when the microLoad.net is initialized. 

4.  Install the new microMate revision. Install to the same directory as your original revision for best re-
sults. You may wish to back up the directory beforehand. 

5.  Select Tools | Upgrade Firmware from the microMate menu and follow the instructions. 

6.  Enter Program Mode, go to the Diagnostics menu, and perform a factory database initialization. This 
will erase the program configuration database, and set all program codes to known values. You can then 
re-enter program mode (the passcode will be 0 again) 
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7.  Via the microLoad.net keypad, program the communications port for microMate communications.   
(See Initiating Communications with the microLoad.net). Enter a valid K-Factor (Product directory pro-
gram code 301). Re-enter any security codes you had programmed. Exit Program mode via the keypad. 

8.  In microMate, open the .ml file that you saved in step 1. Verify that communications is established (unit 
should be in ONLINE mode). Select Dump All. 

9.  Download any files stored in step 2 in the same manner. 

Browse microLoad…: Browses the microLoad.net’s web page with a web browser.  The microLoad.net acts as a 
simple embedded server for the page.  Current run data may be viewed from the page. 

 

Figure 8.    microLoad.net Browser 
   

Options Menu 

Access the Options menu by clicking "Options" on the microMate menu bar. 
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Options for this microLoad.net…: This selection allows the operator to configure communication settings for a 
specific microLoad.net. For more information, refer to "Section III – Communications" in this manual. 

General…: Display and printing options can be selected by modifying entries in the Options dialog box (shown in 
Figure 10). The Options dialog box is accessed by selecting Options|General… . 

Display Options: Click with the mouse in the box beside "Display Security Level in List View" to add the Security 
Level for the parameter to the parameter list view. Click again to suppress this option. 

Printing Options: Click with the mouse in the box beside "Suppress Printing Unused Recipes" to avoid printing 
recipes that are programmed as "Not Used" in Recipe Parameter 001. Click again to suppress this option. 

Click with the mouse in the box beside "Include Security Level on Printout" to add the Security Level for the pa-
rameter to the printed list. From the pull-down menu to the right of "Limit printout of parameters to:", select the se-
curity level that determines which parameters are to print. Click again to suppress this option. 

 

 

Figure 9.    General Options 

 

View Menu 

Access the View menu by clicking "View" on the microMate menu bar. 

Toolbars: Shows or hides the toolbar near the top of the microMate screen. 

Status Bar: Shows or hides the status bar at the bottom of the microMate screen. The status bar indicates 
whether the microMate is online or offline, as well as the current communications settings and status.   

Split: Allows the user to allocate space between the microMate Panes being displayed. 
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Figure 10.    View Menu 
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Editing Program Code Data 

To edit program code data, first open a new or existing microLoad.net data file. Do this by selecting "New" or 
"Open" from the File menu on the microMate toolbar. If "New" is selected, choose "microLoad.net Data File" from 
the pop-up menu. If "Open" is selected, choose an existing microLoad.net file from the File dialog menu. micro-
Load.net files are designated by the file extension ".ml".  

A list of directories will appear on the left of a split screen in the active microLoad.net window. Refer to the Opera-
tor Reference Manual, Bulletin MN06148 for detailed information about directories and the program codes within 
each directory, or click on "Help" at the far right of the microMate toolbar.) Clicking on "Communications," for ex-
ample, causes a listing of all program codes within the Communications Directory to appear on the right-hand 
screen, as shown in Figure 12. Double-click on one of these program codes to display a dialog box. 

This dialog box, "Edit Program Code Data," contains information about the selected program code. For the cur-
rently-selected code, this dialog box provides a pull-down menu with all valid options and value ranges, or a text 
box for text program codes. When new information is selected from the pull-down menu, the new value appears 
on the active microLoad.net data file screen. 

 

Figure 11.    Communications Directory 

http://info.smithmeter.com/literature/docs/mn06148.pdf
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To access the program code dialog box shown in Figure 13 select "Configuration" | “Pulse Outputs” then double-
click on "101 Pulse Output Function" in the right-hand window. The dialog box will then appear. 

 

Figure 12.    Parameter Editing 
 
The program code shown in Figure 13 has a pull-down pick list. To access the pick list, use the mouse to click on 
the down arrow at the right of the box labeled "New," then highlight the desired option and click OK. 
If the microLoad.net is currently online and communication with the microMate is active, the new value will be ef-
fective after a few seconds; otherwise, the value change will have to be dumped to the microLoad.net when 
communication is established. 

Other dialog boxes require the operator to type in alphanumeric data. An example of this is the box shown in Fig-
ure 14. This particular box is selected by clicking on "General Purpose," then highlighting "112 Flow Rate De-
scriptor" from the menu of program codes in the window on the right. The resulting dialog box prompts the opera-
tor to type up to three characters (in any combination of letters and/or numbers) in the box labeled "Enter New 
Value." Once the updated information has been typed in the box, the operator clicks on OK to save the current 
data. The new data will appear in the "Value" column in the window on the right. 

 

Figure 13.    Parameter Editing 
 
The third type of dialog box allows only numeric entries. An example of this type of box is shown in Figure 15. 
This particular box is selected by clicking on the “General Purpose” menu, then highlighting "131 Dynamic Display 
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Timeout." The dialog box prompts the operator to enter a number from zero to 99. Once the updated information 
has been typed in the box, the operator clicks on OK to save the current data. All boxes of this type display help 
messages that include the range of the entry and other pertinent information. 

 

Figure 14.    Parameter Editing 
 
Finally, there is the dialog box listing available options selectable with check boxes, as shown in Figure 16. To ac-
tivate an option, the operator uses the mouse to position the cursor in the box to the left of the desired option, 
then clicks once in the box. A checkmark appears to indicate that the option has been selected. To deactivate an 
option, position the cursor on the check and click once with the mouse. The checkmark will disappear. Click on 
"OK" to store changes. The new selection will appear in the value column in the window on the right. Access the 
dialog box by choosing “Alarms," then "System 639 Low Density Alarm."  
 

 
 

Figure 15.    Parameter Editing 
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Using the Terminal Emulator 

The Terminal Emulator is a "smart" terminal emulator that formats commands to be sent to the microLoad.net. It is 
accessed by selecting Tools|Terminal Emulator from the microMate toolbar. Terminal Emulator supports both 
Terminal and Minicomputer modes, and processes all required framing characters. The operator types only the 
actual command and any associated command qualifiers. From this interface, the operator can send any of the 
commands in the microLoad.net repertoire. 

The Terminal Emulator adds a new pull-down menu, "Commands," to the menu bar. From this menu, the operator 
can browse all commands in the microLoad.net command set. As each command is highlighted, information 
about the command will appear on the application's status bar. Once an item is selected, pressing "F1" will dis-
play the help message for that particular command. If a command requires no additional information, it will be 
sent immediately. 

Refer to the microLoad.net Communications Manual, MN06147, or the imbedded “HELP” feature for additional in-
formation about microLoad.net commands. 
 

 

Figure 16.    Terminal Emulator Window 

 

 

 

 

 

 

 

 

 

 

http://info.smithmeter.com/literature/docs/mn06147.pdf
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Report Editor 

The Report Editor uses a combination of basic Windows commands (e.g., Cut, Copy, and Paste) and simple val-
ue descriptions to create customized reports. Access the Report Editor by selecting File|New|Report Configura-
tion from the microMate menu bar. 

"Insert New Item," "Edit Selected Item," "Cut," "Copy," and "Paste" are accessed by clicking "Edit" on the micro-
Mate toolbar, then selecting the desired option from the pull-down menu. 

Insert New Item Opens a dialog box from which a new item can be added to the report. 

Edit Selected Item Opens a dialog box from which an existing report item, when highlighted, can be 
modified. 

Cut The item highlighted on the Report Editor will be cut from the display and stored 
on the clipboard. 

Copy The item highlighted on the Report Editor will be copied to the clipboard. 

Paste The information stored on the clipboard will be pasted to the Report Editor  
window at the specified row and column. 

Read Report from  

microLoad.net 

Uploads a report from the microLoad.net. (This option is only available when the 
microMate is online.) 

Dump Report to 

microLoad.net 

Downloads a report to the microLoad.net. (This option is only available when 
the microMate is online.) 

"Line," "Column," "Item Type," "Item Value," and "Format String" are accessed by moving the cursor to the appro-
priate option on the "Edit Report Item" dialog box. The "Edit Report Item" box appears whenever an existing re-
port item on the Report screen is double-clicked.  

Line Indicates the row on which the data to be displayed is entered. 

Column Indicates the column in which the data to be displayed is entered. 

Item Type Selects the type of data to be entered on the screen. The choices are as fol-
lows: 

 User-defined text entry Displays text typed in the Item Value entry.  (24 characters max.) 

 Database value Displays the database value for a selected register. 

 Database Description Displays the database descriptive text for a selected register. 

Item Value Displays the current value of the register; or, if a user-defined text entry is  
selected as Item Type, the text is entered here. 

Format String The format string designates the type of data to be displayed. The strings used 
in the microLoad.net are based on ISO ‘C’ language standards and are as fol-
lows: 

 %uc Data labeled as "Byte" microLoad.net (unsigned character) 
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 %f Data labeled as "DP Float" or "Double Precision Floating Point." Specify the 
length of the numeric data in this field. (The microLoad.net stores all double 
precision floating point data as ten digits.) Using the number 0.2 between the 
"%" and the "f" right-justifies the data five places and truncates the data to two 
decimal places (i.e., %0.2f). This field can be used to line up the numerical data 
on the screen by entering an "8" between the "%" sign and the "f" (i.e., %8f). If 
the requirement is to both line up the data and truncate to two decimal places, 
the entry would be %8.2f. 

 %d Data labeled as an integer in the microLoad.net database. 

 %s Data labeled as a string in the microLoad.net, consisting of multiple characters. 

Note 1: The "Edit Report Item" dialog box may also be opened by right-clicking on an existing report item, then 
selecting "Properties." 

Note 2: Existing report items may be moved from one location to another on the Report screen by clicking the 
item with the mouse, then dragging it to another position. Hold "Ctrl" while dragging to copy an entry. This method 
may also be used to move or copy items to another report. 

Note 3: The Report Item “REPRINT” should always be included as the first item on any report. 

 



Section IV – Operations 

 

MN06152 Issue/Rev. 0.2 (10/13) 25 

To create a customized report, do the following. 

1. Access Report Editor by selecting File|New|Report Configuration from the microMate menu bar. A display 
similar to that shown in Figure 17 below will appear. 

 
 

Figure 17.    Report Configuration 
 
2. Next, select Edit|Insert New Item… from the microMate menu bar. An "Edit Report Item" dialog box will ap-

pear, similar to that shown in Figure 18. 
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Figure 18.    Insert/Edit Report Items 
 
3. In the boxes labeled "Line" and "Column," indicate the position of the new report item. In box labeled “Item 

Value” enter the text to be displayed in that position, Line 1, Column 1 – is the upper left-hand corner of the 
report. There are 60 lines and 80 columns on a single page of an microMate report. 

4. Next, select "Item Type" from the pull-down menu shown in Figure 18. There are three options: "Run/Program 
Data Value," "Run/Program Data Description," and "User-defined Text." More about these options appears 
later in this subsection.  

5. To display custom information such as a company name, select "User-defined Text," type the desired infor-
mation in the "Item Value" box, and click "OK." The text will appear in the appropriate position on the report 
screen shown in Figure 18.  

6. If "Run/Program Data Value" or "Run/Program Data Description" is selected, click on "Change" beside the 
"Data Register" box. A menu of selections will appear. Choose an item by highlighting and double-clicking. 

7. Note that the format of the new entry must be appropriate for its type. A sample report appears in Figure 18. A 
corresponding table immediately following the figure details the item, entry type, register, format string, posi-
tion, and location for each element on the report. 
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Advanced Report Options 

microMate's Report Editor offers certain advanced configuration features that allow the operator to modify format 
strings, as well as the number of digits to be printed. Normally, no modification is required. microMate follows the 
"C" programming language standard for the "printf" function format string. 

To access the Report Editor's advanced features, choose Edit | Insert New Item… from the microMate toolbar. A 
dialog box, similar to that shown in Figure 18, will appear. Use the mouse to click on the "Advanced" button in the 
lower right-hand corner of the screen to obtain the dialog box shown in Figure 20. 

 

Figure 19.    Edit Report Item 
 

 

 

Use Alternate Print Format 

The primary benefit to the "Use Alternate Print Format" feature is the option of editing field sizes. For example, the 
designation %8.3f indicates a total field size of eight characters, with three numbers to the right of the decimal 
point. The printed report format is XXXX.XXX. (See Figure 19.) To eliminate one decimal place in this example, 
use the mouse to highlight the "3", then type "2". The format string for this report item is now %8.2f and the print-
ed report format is XXXXX.XX. 

Reference Register 

This feature allows the selection of an alternate database point that may be used to either determine the offset to 
use for the report item, or aid in determining whether the report item should be suppressed for this printing. 

Use Reference Register Value as Offset for this Item 

If checked, the database value offset specified for this report item (the register specified on the previous dialog) 
will be replaced. The actual offset used to determine the value printed is the value of the reference register. The 
typical application for this feature would be to print the correct recipe name. On the base dialog, the database val-
ue "Recipe ID" may have been selected. On the report, the operator may wish to print the recipe name of the rec-
ipe delivered for this batch; however, the batch data contains only the recipe number. To print the actual recipe 
name, specify the Batch x Recipe number for the reference register and select this checkbox. 
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Restrictions 

This combo box allows the selection of a test function. The microLoad.net may either print or skip this report item, 
depending on the result of the specified conditional. The default is to always print the entry. 

Always print this entry – The default option. 

Print if value is nonzero – Only print this entry if the value of the entry is greater than zero (database entry types 
only). 

Print if reference value is nonzero – Only print this entry if the value of the database entry specified by the ref-
erence register is zero (any entry type can use this restriction). 

Print if indicated batch was delivered – Only print this entry if the batch offset associated with the entry was de-
livered in the transaction (only valid for database entries with a "batch #" offset). 

Print if reference register's batch was delivered – Only print this entry if the batch offset associated with the 
reference register's batch was delivered in the transaction (the reference register must be a database register with 
a "batch #" offset). 

Print if this product was delivered – Only print this entry if the product offset for this entry was a product deliv-
ered in this transaction (only valid for database entries with a "product #" offset). 

Print if reference register's product was delivered – Only print this entry if the product offset for the reference 
register was a product delivered in this transaction (reference register must be a database entry with a "product #" 
offset). 

Print if this recipe was delivered – Only print this entry if the recipe offset for this entry was a recipe delivered in 
this transaction (only valid for database entries with a "recipe #" offset). 

Print if reference register's recipe was delivered – Only print this entry if the recipe offset for the reference reg-
ister was a recipe delivered in this transaction (reference register must be a database entry with a "recipe #" off-
set). 
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Sample Report  

 
Figure 20.    Sample Report 

Reprint

Bill of Lading                                    Date   NNNNNNNNNNNNN

Transaction Number  NNNNN

Gross Volume (GV)                                      0.00

Gross Volume @ Std Temp (GST)               0.00

Indicated Volume (IV)                                   0.00

Total Pulses                                                       0

Average Flow Rate                                         0.0

Mass Total                                                    0.00

Additive 1 Volume                                       0.000

Additive 2 Volume                                       0.000

This is to certify that the above named materials are properly classified,

described, packaged, marked, and labeled and are in proper condition for

transportation according to the applicable DOT regulations.

__________________________

Driver Signature

__________________________

Signature of Receiving Agent
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Figure 21.  Sample Report Generation 

 

 

Item Type 
Format 

String 
Row Column Where Found 

Reprint User-defined Text %s 1 1 --- 

Bill of Lading User-defined Text %s 3 1 --- 

Date Run/Program Data 
Description 

%s 3 37 System Configuration 

Date Run/Program Data 
Value 

%s 3 47 System Configuration 

Transaction Number Run/Program Data 
Description 

%s 5 1 Transaction Data 

Transaction Number Run/Program Data 
Value 

%5.0u 5 21 Transaction Data 

Batch P1 Gross 
Volume (GV) 

Run/Program Data 
Description 

%s 7 1 Batch Data 
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Item Type 
Format 

String 
Row Column Where Found 

Batch P1 Gross 
Volume (GV) 

Run/Program Data 
Value 

%10.2f 7 42 Batch Data 

Batch P1 Gross @ 
Std Temp (GST) 

Run/Program Data 
Description 

%s 8 1 Batch Data 

Batch P1 Gross @ 
Std Temp (GST) 

Run/Program Data 
Value 

%10.2f 8 42 Batch Data 

Batch P1 Indicated 
Volume (IV) 

Run/Program Data 
Description 

%s 9 1 Batch Data 

Batch P1 Indicated 
Volume (IV) 

Run/Program Data 
Value 

%10.2f 9 42 Batch Data 

Batch P1 Total 
Pulses 

Run/Program Data 
Description 

%s 10 1 Batch Data 

Batch P1 Total 
Pulses 

Run/Program Data 
Value 

%8.1f 10 42 Batch Data 

Batch P1 Average 
Flow Rate 

Run/Program Data 
Description 

%s 11 1 Batch Data 

Batch P1 Average 
Flow Rate 

Run/Program Data 
Value 

%8.1f 11 44 Batch Data 

Batch P1 Mass 
Total 

Run/Program Data 
Description 

%s 12 1 Batch Data 

Batch P1 Mass 
Total 

Run/Program Data 
Value 

%10.2f 12 42 Batch Data 

Additive 1 
Volume 

Run/Program Data 
Description 

%s 14 1 Batch Data 

Additive 1 
Volume 

Run/Program Data 
Value 

%8.3f 14 44 Batch Data 

Additive 2 
Volume 

Run/Program Data 
Description 

%s 15 1 Batch Data 

Additive 2 
Volume 

Run/Program Data 
Value 

%8.3f 15 44 Batch Data 

This is to certify… User-defined Text %s 19 1 N/A 

the above… User-defined Text %s 19 25 N/A 

als are… User-defined Text %s 19 50 N/A 

fied. User-defined Text %s 19 75 N/A 

described, … User-defined Text %s 20 1 N/A 

rked, and… User-defined Text %s 20 25 N/A 

are in proper… User-defined Text %s 20 50 N/A 

for User-defined Text %s 20 75 N/A 

transportation… User-defined Text %s 21 1 N/A 

g to the applicable… User-defined Text %s 21 25 N/A 

regulations. User-defined Text %s 21 50 N/A 
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signature line User-defined Text %s 25 1 N/A 

Item Type 
Format 

String 
Row Column Where Found 

signature line User-defined Text %s 25 25  

Driver Signature User-defined Text %s 26 1 N/A 

signature line User-defined Text %s 30 1 N/A 

signature line User-defined Text %s 30 25  

Signature of  
Receiving  

User-defined Text %s 31 1 N/A 

Agent User-defined Text %s 31 25  

 
Note: The first entry on any report should be the text "Reprint." This text will only appear on reports that are reprinted; it will not appear on the 
first report printed. 
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Translation Editor 

The microMate's Translation Editor makes it possible to replace any of the text literals in the microLoad.net with 
customized text. The interface consists of a list view with the original text in the left-hand column and an edit 
space in the right-hand column, as shown in the figure below. The Translation Editor is accessed by selecting 
File|New|Translation from the microMate toolbar or by opening an existing translation (.LGM) file. 

 
 

Figure 22.    Translation 
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A search feature allows the operator to quickly locate a specific entry by matching the text in either the original or 
translated literal. To use the search feature, select Edit|Find (with the Translation Editor open). A dialog box simi-
lar to that shown in the figure below will appear on the screen. 

 
 

Figure 23.    Search for Text 

 
 
To conduct a search, type the desired text in the "Text to Find" box, specify the direction of the search, and click 
"Find." The specified text will be highlighted. Additional search options, "Ignore Case" and "Find From Cursor," 
are located on the left-hand side of the dialog box. Select these options, if desired, by using the mouse to click in 
the box to the left of each option. An "x" will appear in the box. 
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To change a text literal, take the following steps. 

1. Double-click on the literal to be edited. A dialog box, similar to that shown in Figure 24, will appear on the 
screen. 

2. Type the new text in the space on the bottom half of the dialog box.  

3. Click "OK" to exit and save changes, "Cancel" to abandon the change, or "Help" for more information about 
this function. Assuming that new text was entered, it will appear to the right of the Translation Editor screen, 
as shown in Figure 25. The new literal, once downloaded to the microLoad.net, will appear in place of the 
original literal. 

 

 
 

Figure 24.    Editing Text
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Figure 25.    Translation Screen
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Driver Database Editor 

The Driver Database Editor uses a combination of basic Windows commands (e.g., Cut, Copy, and Paste) and 
simple value descriptions to create or edit Driver Databases. Access the Driver Database Editor by selecting 
File|New|Driver Database from the microMate menu bar. 

"Cut," "Copy," and "Paste" are accessed by clicking "Edit" on the microMate toolbar, then selecting the desired 
option from the pull-down menu. 

Cut The item highlighted on the Report Editor will be cut from the display and stored 
on the clipboard. 

Copy The item highlighted on the Report Editor will be copied to the clipboard. 

Paste The information stored on the clipboard will be pasted to the Report Editor  
window at the specified row and column. 

Read all driver card entries 

from microLoad.net 

Uploads a Driver Database from the microLoad.net. (This option is only availa-
ble when the microMate is online.) 

Dump driver card database 

to microLoad.net 

Downloads a Driver Database to the microLoad.net. (This option is only availa-
ble when the microMate is online.) 

 
 
The Driver Database Screen resembles a spreadsheet (See Figure 28) with rows (records) dedicated to individual 
driver cards and columns dedicated to the driver’s ID Number, HID Number, PIN, and Field #1, #2, and #3 to be 
assigned. 
 
Entries are made in the database by double-clicking on the row where the entry or edit is to be made.  This opens 
a dialog box which permits entry of all the data categories for that driver.  
 
When using the Driver Database and Driver IDs, the data in the user fields can be placed on the configurable re-
port in Revision 00.05 and above.  
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Figure 26.    Driver Database Form 
 
 
 

 
 

Figure 27.    Driver Database Record Editor 
 
 
The HID# is entered using it’s own dialog box. Proximity cards manufactured by HID have a 5-digit ID number 
printed on them, but this number is not equivalent to the raw card data the card reader will send to the micro-
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Load.net. This dialog will convert the number printed on the card to the same format as encoded on the card. On-
ly 26-bit cards are supported at this time. 
The Extended Code should always be 2 for 26-bit cards. The Facility Code is typically set to a 7 by HID unless 
requested otherwise. 
 

 
 

Figure 28.    HID Number Entry 
 
 

Display Configuration Editor 

The Display Configuration Editor allows the user to customize the layout of the microLoad’s Run Display.  The 
Display Configuration is very similar in functionality to the Report Editor. The Display Configuration workspace is 
limited to 8 lines and 21 columns. Access the Report Editor by selecting File|New|Report Configuration from the 
microMate menu bar. 

 

 
 

Figure 29.    Display Configuration 
 
 
Like the Report Editor, the Display Configuration process uses a dialog box to define each of the items found on 
the display. 
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Figure 30.    Display Item
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microMate Equation Editor 

The microMate makes it easy for the operator to direct the microLoad.net to perform certain functions that are ex-
ecuted on a periodic basis. The microMate Equation Editor allows the operator to create application specific cal-
culations, as well as to insert, delete, reorder, and edit existing equation lines. The Equation Editor is accessed by 
selecting File|New|Equation Set. Doing so will result in a display similar to that shown in the figure below. 

 
 

Figure 31.    Equation Programming Screen 

 

Next, select Edit|Insert New to obtain the dialog box shown in Figure 32. Use the pull-down menu at the top of the 
display to indicate the type of equation to be set. An explanation of Boolean and algebraic expressions is included 
in the next subsection of this manual. 
 

 

Figure 32.    Equation Editor 
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Boolean/Algebraic Statements 

Boolean statements have two conditions: “true” or “false.”  They may also be represented as "on" or "off," or as in-
teger values from 0 to 255. Any non-zero value is considered true; zero is false. Boolean statements can be used 
to create customized instructions to monitor inputs, control outputs, and calculate report values. The instructions 
are defined at the microMate, then downloaded to the microLoad.net. The different ways of expressing Boolean 
statements are shown below: 

 TEMPBOOL1 = true   
 TEMPBOOL1 = on Equivalent statements  
 TEMPBOOL1 = 1   
    
 TEMPBOOL2 = false   
 TEMPBOOL2 = off Equivalent statements  
 TEMPBOOL2 = 0   
 

The logical operators used in conjunction with Boolean statements are “NOT”, “AND”, “OR”, and “XOR”.  

Refer to these definitions when studying the examples below: 

 TEMPBOOL1 = True 

 TEMPBOOL2 = True 

 TEMPBOOL3 = False 

NOT A Boolean logic operator indicating negation. A variable designated with a “NOT” in 
front of it will be the opposite of its current value. It is a switching function for one var-
iable. 

Example: TEMPBOOL4 = NOT TEMPBOOL3 (True) 

AND A Boolean logic operator. If two variables are involved, both must be true for the out-
put to be true. 

Example: TEMPBOOL5 = TEMPBOOL1 AND TEMPBOOL2 (True) 
Example: TEMPBOOL6 = TEMPBOOL1 AND TEMPBOOL3 (False) 

OR A Boolean logic operator. Using two variables, only one needs to be true for the out-
put to be true. 

Example: TEMPBOOL7 = TEMPBOOL1 OR TEMPBOOL3 (True) 

XOR An exclusive or Boolean logic operator in which the output is true if either of two vari-
ables is true but not if both are true. 

Example: TEMPBOOL8 = TEMPBOOL1 XOR TEMPBOOL3 (True) 
Example: TEMPBOOL9 = TEMPBOOL1 XOR TEMPBOOL2 (False) 
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Algebraic operators used in conjunction with algebraic statements are as follows: 

 “ + ” - Used to add two numerical values (2 + 2 = 4) 

 “ - ” - Used to subtract two numerical values (4 - 2 = 2) 

 “ * ” - Used to multiply two numerical values (2 * 2 = 4) 

 “ / ” - Used to divide two numerical values (1/2 = 0.5) 

 “ABS” - Used when the absolute value of a number is required ( | -2 | = 2) 

 “POW” - Used to take a number to a power (2POW2 = 2
2
) 

 
Conditional operators used in conjunction with Boolean and algebraic statements are as follows: 
 

 “IF” - Used in statements where if a condition exists, then another event is to occur 

 “ < “ - Less than (1 < 2) 

 “ > ” - Greater than (2 > 1) 

 “ <= “ - Less than or equal to (1 <= 2) 

 “ >= “ - Greater than or equal to (2 >= 2) 

 “ = “ - Equal to (1 = 1) 

 “ != “ - Not equal to (1 ! =  5) 
 

All processing is from left to right and top to bottom 

Example:  1   +   3   *   4   /   2   -   1   

       4 

   16  

           8 

 
   7 

 

There are 50 Boolean registers and 50 float registers. The maximum number of instruction lines per equation set 
is 50, and the maximum number of operations per statement is 4. All Boolean and algebraic equations for an mi-
croLoad.net must be stored in a single file, and all changes to equations must be made in this file. 
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Specific Boolean Expressions 

When constructing a set of equations that take action based on a level value (such as a temperature, a status 
value, the state of a digital I/O point, or any other value that may change between the evaluation of one equation 
and the next), read the value into a temporary or user-defined variable (Boolean or float, as applicable) and use 
the variable, not the actual value, in multiple equations. 

Boolean equations can be more clearly expressed as a result of an evaluated expression than by assigning a val-
ue conditionally. For example, let us assume that we want to turn on a digital output when the product tempera-

ture of the meter is between 70 and 90, inclusive, and turn the same digital output off again when the tempera-
ture is no longer within that range. Because of the left-to-right evaluation of Boolean and algebraic expressions, it 
is recommended that the expressions be broken down into simple expressions so that the results are as ex-
pected. 

TEMPBOOL1 = Product Run Data (1) Current Product Temperature >=70 
TEMPBOOL2 = Product Run Data (1) Current Product Temperature <=90 
OUTPUT1 = TEMPBOOL1 AND TEMPBOOL2 

 

Setting a Timer 

Eight timers are available in the microLoad.net. The breakdown is as follows: 

 2 - 0.1 (Tenth) Second 

 2 - 1 (One) Second 

 2 - 1 (One) Minute 

 2 - 1 (One) Hour 
 
A timer can be started by writing a 1 to it, and reset by writing a 0. Timers will hold values from 0 to 65535. To in-
struct a time to count down, set it to a negative number. For example, if Timer3 is set to –20, it will stop in 20 se-
conds. If a continuously running timer is desired, include a line in the expression that resets the timer to 1 when it 
stops. 
 

Timer3 = 1 IF Timer3 = 0 
 

Setting an Alarm 

Five user alarms are available in the microLoad.net. These alarms are programmable, and clearable in Run or 
Ready mode. A text string of up to 18 characters may be associated with each alarm. The set commands availa-
ble are as follows: 
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 Set Alarm Output #1 

 Set Alarm Output #2 
 

Inputs and Outputs 

The microLoad.net can monitor any of the 3 digital and 2 analog inputs, and control any of the 6 digital outputs us-
ing operator-configured Boolean commands. Outputs can be configured for general purpose applications, and can 
be turned on or off by equations. 

  

Variables and Registers 

Temporary variables include the following: 

 TEMPBOOL1 to TEMPBOOL50 

 TEMPFLOAT1 to TEMPFLOAT50 

 Place holders used by other instruction lines. 
 
User memory consists of the following: 
 

 USERBOOL1 to USERBOOL50 

 USERFLOAT1 to USERFLOAT50. 
 
All variables and registers can be read and written to by equations. They can also be accessed via microMate 
communications and their values included in user-configured reports.  
 
 

Possible Boolean Applications 

In addition to the applications listed above, several other operations can be initiated or controlled using Boolean 
equations. These include the following: 

 Periodic maintenance notification 

 Relay output at first trip point 

 Viscometer input set points 

 Detection of density change 

 Temperature calculations (C, F or K) 

 Close safety valve on an overrun alarm. 
 

Example A: Closing a relay (and safety valve downstream of a digital control valve) in the event of an overrun 
alarm 

 
OUTPUT4 = System Alarm Status OA: System Overrun Alarm 
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Take the following steps to initiate this action. 

1. With the microMate program open, go to File/New/Equation Set. 

2. Click on Edit/Insert New 

3. From the "Edit Equation Line" screen, top box, select the output to be configured for this function. (Note: the 
output must be configured for general purpose use in the configuration.) For this example, we will use output 
#4. 

4. Move the cursor to the box directly below and delete the 0. 

5. Move the mouse to the button for @register and click. 

6. From the "Select Data Item" screen, select the system alarm status by double clicking on it. 

7. Move the cursor down to OA: System Overrun Alarm. 

8. Click on the OK button. 

9. The microMate will display @152572160 (register number) in the second box. Directly below the register 
number will be displayed “OUTPUT4 = System Alarm OA, Overrun Alarm.” 

10. Click on OK. The register and alarm information will be transferred to the scratch pad. 

11. The equation can now be downloaded to the microLoad.net by clicking on the "Dump Selected Item" button. 

12. The equation can be saved as a file for future use by going to "File/Save As" and assigning a file name to the 
data. Equation files have a .eq extension. 

Example B: Closing a relay (and safety valve downstream of a digital control valve), unless intervention has oc-
curred either through the keypad or through communications 

TEMPBOOL1 = System Alarm Status OA: System Overrun Alarm; check USERBOOL1 if not 0 ignore alarm, keep 
valve open 

TEMPBOOL2 = TEMPBOOL1 AND NOT USERBOOL1; check USERBOOL2 if not 0 close valve always 
OUTPUT 4 = TEMPBOOL2 or USERBOOL2 

Take the following steps to initiate this action 

1. With microMate program open, go to File / New / Equation set. 

2. Click on Edit/Insert New. 

3. From the Edit Equation Line screen, top box, select the temporary Boolean storage. 

4. The box to the right will indicate this is register1. 

5. Move the cursor to the box directly below and delete the 0. 

6. Move the mouse to button for @register and click. 

7. From the Select Data Item screen, select System Alarm Status by double clicking the left hand button on the 
mouse. 
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8. Move the cursor down to OA: System Overrun Alarm. 

9. Click on the OK button. 

10. The microMate will display @152572160 (register number) in the second box. Below that box will be dis-
played “TEMPBOOL1 = System Alarm OA, Overrun Alarm.” 

11. Click on OK to transfer the data to the scratch pad. 

12. Click on Edit/Insert New to start next item. 

13. The next line is a comment line for a reminder of what the next statement will do. From the Edit Equation Line 
screen, top box, select “comment only” for this line. 

14. Move the cursor to the box directly below and delete the 0. 

15. Type in the comment “check USERBOOL1 if not 0 ignore alarm, keep valve open.” 

16. Click on OK to transfer the comment to the scratch pad. (Note: Comments are not downloaded to the micro-
Load.net; therefore, if equations are uploaded from an microLoad.net, the comment lines will not appear.) 

17. Click on Edit/Insert New Item to start the next item. 

18. From the Edit Equation Line screen, top box, select Temporary Boolean Storage. 

19. Move the cursor to the box at the right and change the number from 1 to 2. 

20. Move the cursor to the box directly below and delete the 0. 

21. Enter "TEMPBOOL1 AND NOT USERBOOL1" (AND and NOT can either be typed or selected from the but-
tons below). 

22. Click on OK to transfer the statement to the scratch pad. 

23. Click on Edit/Insert New to start a new item. 

24. The next line is a comment line for a reminder of what the next statement will do. From the Edit Equation Line 
screen, top box, select "Comment Only" for this line. 

25. Move the cursor to the box directly below and delete the 0. 

26. Type in the comment "Check USERBOOL2 if not 0 close valve always". 

27. Click on OK to transfer the statement to the scratch pad. 

28. Click on Edit/Insert New Item to start the next item. 

29. From the Edit Equation Line screen, top box, select "OUTPUT4." 

30. Move the cursor to the box directly below and delete the 0. 

31. Enter "TEMPBOOL2 OR USERBOOL2" (OR can either be typed or selected from the buttons below). 

32. Click on OK to transfer the statement to the scratch pad. 



Section V – Programmable and Boolean Statements 

 

 MN06152 Issue/Rev. 0.2 (10/13) 48 

33. The expression is now complete. The file can be saved or downloaded to the microLoad.net and/or another 
expression can be added to the file. 

 

Example C: Turn on digital output #1 when the product temperature is between 175 and 250. 

TEMPBOOL1 = Product Run Data (1) Current Product Temperature >= 175 
TEMPBOOL2 = Product Run Data (1) Current Product Temperature <=250 
TEMPBOOL3 = TEMPBOOL1 AND TEMPBOOL2 
OUTPUT1 = ON if TEMPBOOL3 
OUTPUT1 = OFF if NOT TEMPBOOL3 

or 

TEMPBOOL1 = Product Run Data (1) Current Product Temperature >=175 
TEMPBOOL2 = Product Run Data (1) Current Product Temperature <=250 
OUTPUT1 = TEMPBOOL1 AND TEMPBOOL2 

Both of these groups of statements will yield the same results. Note that Product Run Data (1) Current Product 
Temperature appears as Register 68224001 when selected and before moved to the file. 

 

Example D: Convert the current temperature (Celsius) to Fahrenheit 

USERFLOAT1 = Product Run Data (1) Current Temperature * 1.8 + 32 

Note that the current temperature register is 68224001. 
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Algebraic Expressions 

The microLoad.net converts all algebraic values to double precision floating point values prior to performing calcu-
lations. 

Calculations may be defined using positive or negative whole numbers, fractional numbers, or a combination. Al-
gebraic expressions are evaluated from left to right and all operators (+, -, /, *) have the same precedence. Multi-
plication does not take place before addition, etc. The following expression has a result of 54. 

TEMPFLOAT1 = 4 + 5 * 6 (Result 54, 4 + 5 = 9 * 6 = 54) 

Algebraic processing will allow out of range values, such as division by zero, or evaluations of expressions whose 
results are greater than the range of a double precision floating point variable. It is the responsibility of the user to 
ensure that valid expressions are used. 
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